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1. Einführung 

UGM192 bietet eine ultra-kompakte Schnittstelle mit 24-bit / 192kHz / 114dB Audioqualität 
zwischen einer elektrischen Gitarre und dem Signal eines dynamischen oder Kondensatormikrofon 
und dem USB-Port Ihres PC oder Mac oder einem Mobilgerät, wie ein Smartphone oder Tablet mit 
USB-Audiounterstützung. Auf der Rückseite steht ein Stereoausgang für die Wiedergabe und das 
Mithören (z.B. über Kopfhörer) bereit. All das macht UGM192 zu einem perfekten Werkzeug, 
optimal für Aufnahmen im Studio oder unterwegs. Verwenden Sie das Interface um Gitarren- und 
Mikrofonsignale zu mischen und sie mit Ihrem PC oder Mac, Notebook oder Desktop, in Echtzeit zu 
verarbeiten und das Ergebnis direkt über Kopfhörer abzuhören - ohne zusätzliche Geräte: UGM192 
arbeitet direkt zwischen der Gitarre, dem Mikrofon und Ihrem Computer bzw. Mobilgerät. 

UGM192 ist ein USB-C Gerät, das für den USB 3.1 Anschluss optimiert wurde. Es ist ebenfalls zu 
herkömmlichen USB 2.0 Anschlüssen kompatibel. 

1.1 Leistungsmerkmale 

Die Vorder- und die Rückseite von UGM192 besitzt die folgenden wichtigen Merkmale: 

 
 

1. Hi-Z Instrumenteneinfang Kanal 1 mit unsymmetrischem 6.3mm Klinkenanschluss. Nutzen 
Sie diese Buchse für eine elektrische Gitarre oder für vergleichbare Instrumente. 

2. Mikrofoneingang Kanal 2 mit symmetrischem 6.3mm Klinkenanschluss. Nutzen Sie diese 
Buchse für den Anschluss eines dynamischen Mikrofons oder eines Kondensatormikrofons. Falls 
Sie ein Anschlusskabel für ein Mikrofon mit XLR-Anschluss benötigen, muss das Kabel laut 
folgendem Diagramm hergestellt werden: 

 

Bitte beachten Sie bei der Herstellung eines Kabels, dass der Klinkenstecker symmetrisch 
ausgeführt sein muss (= quasi "Stereo"). 
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3. Kopfhörer- und Line-Ausgang mit unsymmetrischem 6.3mm Stereo-Klinkenanschluss. 
Nutzen Sie diese Buchse, um professionelle Kopfhörer anzuschließen, oder um das Gerät mit 
den Eingängen von Studiomonitoren, einem Monitorcontroller oder mit einem Mixer zu 
verbinden. 

4. USB-C Anschluss zur Verbindung mit dem Computer oder Mobilgerät. Nutzen Sie diesen 
Anschluss, um das Gerät mit Ihrem Mac oder PC zu verbinden. Dazu verwenden Sie jeweils 
eines der mitgelieferten USB-C Kabel. Wenn das Gerät aktiviert ist, leuchtet das Power LED 
über dem USB-C Anschluss. 

5. microUSB Stromanschluss zur Verbindung des Geräts mit einer zusätzlichen Stromquelle. 
Während die Hardware über den USB-Bus mit Strom versorgt wird, kann unter Umständen eine 
weitere Stromquelle trotzdem sinnvoll sein (beispielsweise wenn die Stromversorgung durch ein 
Mobiltelefon mit kleiner Batterie nicht ausreicht). In einem solchen Fall können Sie hier eine 
externe Batterie oder ein USB-Steckernetzteil anschließen. Beachten Sie, dass über diesen 
Anschluss keine Datenverbindung zur Aufnahme oder Wiedergabe mit dem PC oder Mac 
möglich ist – dazu verwenden Sie den USB-C Anschluss. 

A. Monitor Taster, mit diesem Taster ist es möglich, das Echtzeit-Hardwaremonitoring zu 
aktivieren. Es gibt drei verschiedene Einstellungen, abhängig davon wie oft der Schalter gedrückt 
wurde: 

1. Wenn er einmal gedrückt wird, leuchtet das MONO LED auf und Sie können das Signal von 
Eingang 1 über die linke Seite und das Signal von Eingang 2 über die rechte Seite des 
Stereoausgangssignals abhören. 

2. Wenn er zweimal gedrückt wird, leuchtet das STEREO LED auf und Sie können das Signal 
von Eingang 1 und das Signal von Eingang 2 jeweils über beide Ausgangskanäle des 
Stereoausgangs abhören. 

3. Wenn Sie dreimal darauf drücken, wird das Monitoring deaktiviert und beide LEDs leuchten 
nicht mehr auf. In diesem Fall werden die Eingangssignale nicht über den Ausgang 
ausgegeben. 

B. Mic Gain Taster, mit diesem Taster wird der Eingangspegel des Mikrofonvorverstärkers von 
Eingangskanal 2 verändert: 

1. Wenn er einmal gedrückt wird, leuchtet das +20dB LED auf und der Eingangspegel wird um 
20dB in der Lautstärke erhöht. 

2. Wenn er zweimal gedrückt wird, leuchtet das +30dB LED auf und der Eingangspegel wird 
um 30dB in der Lautstärke erhöht. 

3. Wenn Sie dreimal darauf drücken, wird die zusätzliche Lautstärkeerhöhung deaktiviert und 
die beiden LEDs werden ausgeschaltet. 

C. +48V Phantomspeisung Taster, mit diesem Taster wird die 48V Phantomspannung zur 
Speisung eines an Eingangskanal 2 angeschlossenen Kondensatormikrofons aktiviert bzw. 
deaktiviert. Wenn die Phantomspeisung aktiv ist, leuchtet das ON LED. Ansonsten nicht. 

Hinweis: Schalten Sie die Phantomspeisung nur ein, nachdem Sie Ihr Mikrofon angeschlossen haben. 
Vermeiden Sie das Einschalten vor dem Anschluss. 

Hinweis: Vor dem Entfernen der Kabel sollte unbedingt die Phantomspeisung deaktiviert werden. 
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2. Installation 

2.1 Systemanforderungen 

UGM192 ist mehr als nur eine herkömmliche Soundkarte – es handelt sich vielmehr um ein 
hochwertiges Audiointerface für den professionellen Einsatz. Aus diesem Grund kann das 
verwendete Computersystem eine wichtige Rolle bei der optimalen Performance von UGM192 
spielen. Höherwertige Komponenten sind dabei durchaus zu empfehlen. 

Minimale Systemanforderungen 

PC 

- Windows 7 / 8 / 8.1 oder 10 (32- und 64-bit) Betriebssystem 
- 1 freier USB 2.0 oder USB 3.1 Anschluss ("Typ A" oder "Typ C") 

Mac 

- OS X / macOS 10.9 oder höher 
- 1 freier USB 2.0 oder USB 3.1 Anschluss ("Typ A" oder "Typ C") 

2.2 Hardwareinstallation 

UGM192 wird einfach an einen freien USB-Steckplatz angeschlossen. Der Anschluss am Computer 
ist wahlweise ein sogenannter "Typ A" oder ein "Typ C" Anschluss, für den jeweils ein eigenes Kabel 
beiliegt. Verbinden Sie ein Ende des mitgelieferten Kabels mit UGM192 und das andere mit Ihrem 
Computer. 

   
 USB "Typ A" Anschluss am Rechner USB "Typ C" Anschluss am Rechner 

2.3 Treiber- & Softwareinstallation 

Nach dem Anschluss von UGM192 wird das Betriebssystem automatisch eine neue Hardware 
erkennen. Um die Hardware mit allen Features zu nutzen, sollten Sie unseren Treiber installieren. 

Wir empfehlen dringend, den Treiber von unserer Webseite www.esi-audio.de herunterzuladen, um 
UGM192 einzurichten. Nur wenn unsere Treibersoftware installiert wird, stehen alle Funktionen 
unter Windows / OS X / macOS zur Verfügung! 

Sie finden immer jeweils die neuesten Treiber und Software für Mac und PC für Ihr UGM192, 
wenn Sie auf folgende Seite in Ihrem Webbrowser zugreifen: 

>>>    http://de.esi.ms/111    <<< 
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2.3.1 Installation unter Windows 

Im Folgenden wird beschrieben, wie UGM192 unter Windows 10 installiert wird. Sollten Sie 
Windows 7, Windows 8 oder Windows 8.1 einsetzen, ist der Ablauf entsprechend. Verbinden Sie 
UGM192 mit Ihrem Computer noch nicht – falls Sie es schon angeschlossen haben, stecken Sie das 
Kabel zuerst aus. 

Sie starten die Installation per Doppelklick auf das Installationsprogramm, einer .exe Datei innerhalb 
des Treiberdownloads von unserer Webseite. Beim Start der Installation zeigt Windows unter 
Umständen einen Sicherheitshinweis an. Stellen Sie sicher, dass Sie die Installation zulassen. Der 
folgende Dialog links erscheint dann. Klicken Sie auf Next und der Dialog rechts wird angezeigt: 

   

Bestätigen Sie diesen durch Klick auf Install. Jetzt werden Dateien kopiert und nach einiger Zeit 
erscheint das folgende neue Fenster: 

 

Bestätigen Sie dieses durch Klick auf Weiter. Es werden erneut Dateien kopiert und möglicherweise 
erscheint nach einiger Zeit ein Windows-Sicherheitshinweis, wie hier zu sehen: 
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Bestätigen Sie diesen durch Klick auf Installieren. Nach einiger Zeit ist die Installation dann 
abgeschlossen und es erscheint dann der folgende Dialog: 

   

Wenn Sie das linke Fenster sehen, klicken Sie auf Fertig stellen. Anschließend wird in vielen Fällen 
das rechte Fenster erscheinen. Wir empfehlen, dass Sie dort Yes, restart the computer now wählen 
und auf Finish klicken, um den PC neuzustarten. 

Sie können UGM192 ab jetzt jederzeit, falls noch nicht geschehen, an den Rechner anschließen. 
Windows wird dann automatisch die Einrichtung vornehmen und Sie können da Gerät nutzen. 

Um die Treiberinstallation zu bestätigen, überprüfen Sie, ob das orangene ESI-Symbol in der 
Taskleiste (wie auf dem folgenden Bild zu sehen) auftaucht. 

 

Falls ja, ist die Treiberinstallation vollständig abgeschlossen. 
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2.3.2 Installation unter OS X / macOS 

Um UGM192 unter OS X / macOS einzusetzen, müssen Sie die Control Panel Software von einem 
Download von unserer Webseite installieren. Dieser Ablauf ist bei allen Versionen von OS X / 
macOS praktisch gleich. 

Das Control Panel wird installiert, indem Sie einen Doppelklick auf die .dmg Datei machen. Dann 
erscheint dieses Fenster im Finder: 

 

Um das UGM192 Panel zu installieren, klicken Sie mit der Maus darauf und ziehen sie nach links auf 
Applications - dadurch wird es in Ihren Programme-Ordner kopiert. 

Die Steuerung einiger Optionen von UGM192 unter OS X / macOS ist auch über die Audio-MIDI-
Konfiguration von Apple möglich (aus dem Ordner Programme > Dienstprogramme), allerdings wird 
für die Nutzung aller Funktionen unsere spezielle Control Panel Anwendung benötigt, die sich nun 
in Ihrem Programme Ordner befindet. 
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3. Windows Control Panel 

Dieses Kapitel beschreibt das UGM192 Control Panel und seine Funktionen unter Windows. Es wird 
über Doppelklick auf das orangene ESI-Symbol in der Taskleiste geöffnet. Das folgende Fenster 
erscheint anschließend: 

 

Das File-Menu beinhaltet die Option Always on Top mit der es möglich ist, dass das Control Panel 
auch immer dann angezeigt wird, wenn Sie mit anderer Software arbeiten. Über Windows Audio 
Settings können Sie die Audioeinstellungen von Windows aufrufen. Im Config-Menu können über 
Factory Defaults die Werkseinstellungen geladen werden und Help > About zeigt 
Versionsinformationen an. Gleich unter den File, Config, DirectWIRE und Help Menueinträgen 
finden Sie die folgenden Funktionen und Bereiche: 

INPUT 

Dieser Bereich zeigt die Eingangspegel der beiden physikalischen Eingangskanäle an. 

OUTPUT 

In diesem Bereich finden Sie Lautstärkeregler für das Wiedergabesignal über die beiden 
Ausgangskanäle. Darunter finden Sie den MUTE Schalter zum Stummschalten des Signals und 
dazwischen eine Pegelanzeige in. 

Um den linken und rechten Kanal gleichzeitig zu steuern (Stereo), bewegen Sie die Maus zwischen 
beide Regler. Ein direkter Klick auf den Regler kann den Kanal unabhängig steuern. 

SAMPLERATE 

Dieser Bereich zeigt die aktuell verwendete Samplerate an, die auch per Klick geändert werden kann 
(solange keine Audiosignale abgespielt oder aufgezeichnet werden). Da UGM192 ein digitales 
Audiointerface ist, werden zur gleichen Zeit die Audiodaten aller Anwendungen immer mit der 
gleichen Samplerate verarbeitet. Nativ werden Sampleraten zwischen 44.1 und 192 kHz unterstützt. 
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3.1 Latenz- und Puffereinstellungen 

Über den Menupunkt Config > Latency im Control Panel kann die Latenzzeit für den Treiber von 
UGM192 eingestellt werden. Eine kleinere Latenzzeit wird durch Auswahl einer kleineren 
Puffergröße durch einen kleineren Wert verwendet. Je nach Anwendung (z.B. für die Wiedergabe 
von Softwaresynthesizern) ist eine kleinere Latenzzeit von Vorteil. Gleichzeitig hängt die Latenzzeit 
auch indirekt mit der Performance Ihres Systems zusammen und hängt auch von der System-
auslastung (z.B. die Anzahl aktiver Kanäle und Plugins) ab, was eine Erhöhung der Latenzzeit 
notwendig machen kann. Der Latenzpuffer wird in der Einheit samples eingestellt, wobei diese in 
eine Zeit in Millisekunden umgerechnet werden kann, die von einigen Audioanwendungen auch in 
den dortigen Einstellungen angezeigt wird. Beachten Sie, dass die Latenzzeit eingestellt werden muss, 
bevor Sie Audioanwendungen starten, die UGM192 nutzen. 

Über Config > USB Buffer können Sie die Anzahl der USB Datentransferpuffer, die der Treiber 
verwendet, einstellen. In den meisten Fällen ist es nicht notwendig, diese Einstellung zu ändern, da 
sie jedoch auch einen kleineren Einfluss auf die Audiolatenzzeit hat und auf die Stabilität, können 
Sie diesen Wert optimieren. Welcher Wert auf Ihrem System sinnvoll ist, hängt von einigen Faktoren 
ab, wie z.B. die gleichzeitige Verwendung anderer USB-Hardware und von dem in Ihrem PC 
eingebauten USB-Controllerchip. 

3.2 DirectWIRE und virtuelle Kanäle 

Unter Windows stellt UGM192 eine Funktion bereit, die wir DirectWIRE nennen. Damit sind 
vollständig verlustfreie interne Loopback-Aufnahmen möglich. Das ist ein tolles Feature, um 
beispielsweise Signale zwischen Audioanwendungen zu übertragen, für einen erweiterten Mix-Down 
oder um Signale für Livestreaming-Anwendungen zu erzeugen. 

Hinweis: DirectWIRE ist sehr leistungsfähig und wird nur für besondere Anwendungen eingesetzt. 
Wenn Sie nur reine Aufnahmen machen und Signale abspielen, benötigen Sie DirectWIRE nicht und 
sie sollten hier keine Veränderungen vornehmen. Machen Sie dies nur, wenn sie wissen wozu. 

Um die zugehörigen Einstellungen zu machen, klicken Sie auf DirectWIRE im oberen Menu des 
Control Panels. Folgender Dialog erscheint dann: 

 

In diesem Fenster können sie virtuell die Wiedergabe- (Ausgangs-) Kanäle mit den Eingangskanälen 
über virtuelle Kabel am Bildschirm verbinden. 
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Die drei Spalten heißen INPUT (die physikalischen Eingänge der Hardware), WDM/MME (die 
Wiedergabe-/Ausgabekanäle und Eingangskanäle von Anwendungen, die den Microsoft MME und 
WDM Treiberstandard nutzen) und ASIO (die Wiedergabe-/Ausgabekanäle und Eingangskanäle von 
Anwendungen, die den ASIO Treiberstandard verwenden). 

Von oben nach unten sehen Sie die verfügbaren Kanäle, erst die beiden physikalischen Eingänge 1 
und 2 und dann darunter zwei Paare mit virutellen Kanälen (VIRTUAL), nummeriert von 3 bis 6. 
Sowohl physische als auch virtuelle Kanäle stehen als separate WDM/MME Geräte unter Windows 
und als ASIO-Kanäle in Ihren Audioanwendungen bereit. 

Die beiden Schalter MIX 3/4 TO 1/2 und MIX 5/6 TO 1/2 unten ermöglichen es bei Bedarf, 
Audiosignale von den virtuellen Kanälen 3/4 (bzw. 5/6) auf den physischen Ausgangskanal 1/2 zu 
mischen. 

Die Wiedergabe von MME/WDM und ASIO kann zudem bei Bedarf für die Hardware 
stummgeschaltet werden, indem Sie auf OUT klicken. 

DirectWIRE Beispiel 

Jede Anwendung von DirectWIRE ist individuell und es gibt kaum ein universelles Rezept für jede 
mögliche Anforderung. Im folgenden sehen Sie einige der leistungsfähigen Möglichkeiten als 
Beispiel: 

 

Sie sehen hier Verbindungen zwischen ASIO OUT 1 und ASIO OUT 2 zu WDM/MME VIRTUAL IN 
1 und WDM/MME VIRTUAL IN 2. Dadurch wird die Wiedergabe einer ASIO-Anwendung (z.B. Ihre 
DAW) von Kanal 1/2 zum WDM/MME-Aufnahmegerät 3/4 geleitet, was die Aufnahme oder das 
Livestreaming der Ausgabe der ASIO-Software durch eine Software, die Kanal 3/4 verarbeitet, 
ermöglicht. 

Sie sehen auch, dass die Wiedergabe von Kanal 1/2 (WDM/MME OUT 1 und WDM/MME OUT 2) 
mit dem ASIO-Eingang von Kanal 1/2 (ASIO IN 1 und ASIO IN 2) verbunden ist. Das bedeutet, dass 
alles, was eine MME/WDM-kompatible Software über Kanal 1 und 2 abspielt, durch eine ASIO-
kompatible Software an Eingang 1 und 2 aufgenommen bzw. verarbeitet werden kann. 

Der eingeschaltete MIX 3/4 TO 1/2 Schalter bedeutet, dass alles, was über die virtuellen Kanäle 3/4 
abgespielt wird, über den physischen Ausgang von UGM192 ausgegeben wird. 
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3.3 Windows Audio-Einstellungen 

Im Sound-Dialog der Windows Systemsteuerung, den Sie auch über File > Windows Audio Settings, 
aus unserem Control Panel aufrufen können, finden Sie die Wiedergabe- und Aufnahme-Bereiche: 

   

Im Wiedergabe-Bereich wird das wichtigste MME / WDM Audiogerät angezeigt – von Windows als 
Lautsprecher bezeichnet. Dieses Gerät repräsentiert die Wiedergabekanäle 1 und 2. Zusätzlich 
werden die Geräte für die virtuellen Kanäle UGM192 VCH34 und UGM192 VCH56 angezeigt. 

Um die Windows Systemsounds und Signale von Standardanwendungen wie Ihrem Web-Browser 
oder einem Medienplayer über UGM192 abzuhören, müssen Sie es als Standardgerät auswählen. 
Dazu klicken Sie es an und klicken dann auf Als Standard. 

Im Aufnahme-Bereich werden in einer ähnlichen Liste das Hauptgerät für Kanal 1 und 2 (für die 
Aufnahme der physikalische Eingangssignale) und zwei Geräte für die virtuellen Kanäle UGM192 
VCH34 und UGM192 VCH56 angezeigt. 

Bitte beachten Sie, dass auch andere Audiohardware, die bereits in Ihrem Computer eingebaut ist, 
hier aufgelistet wird. Sie sollten deswegen das gewünschte Standardgerät auswählen. Beachten Sie 
auch, dass viele Audioanwendungen selbst ihre eigenen Einstellungsbereiche dafür haben. 
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4. OS X / macOS Control Panel 

Dieses Kapitel beschreibt das UGM192 Control Panel und seine Funktionen auf dem Mac. Es wird 
über Doppelklick auf das UGM192 Symbol in Ihrem Programme-Ordner aufgerufen. Das folgende 
Fenster erscheint anschließend: 

 

Das File-Menu beinhaltet die Option Always on Top mit der es möglich ist, dass das Control Panel 
auch immer dann angezeigt wird, wenn Sie mit anderer Software arbeiten. Über macOS Audio 
Settings können Sie die Audioeinstellungen von OS X / macOS aufrufen. Im Config-Menu können 
über Factory Defaults die Werkseinstellungen geladen werden und Help > About zeigt 
Versionsinformationen an. Der Hauptdialog hat folgende zwei Bereiche: 

OUTPUT 

In diesem Bereich finden Sie Lautstärkeregler für das Wiedergabesignal über die beiden 
Ausgangskanäle. Darunter finden Sie den MUTE Schalter zum Stummschalten des Signals und 
dazwischen eine Pegelanzeige in. 

Um den linken und rechten Kanal gleichzeitig zu steuern (Stereo), bewegen Sie die Maus zwischen 
beide Regler. Ein direkter Klick auf den Regler kann den Kanal unabhängig steuern. 

SAMPLERATE 

Dieser Bereich zeigt die aktuell verwendete Samplerate an, die auch per Klick geändert werden kann 
(solange keine Audiosignale abgespielt oder aufgezeichnet werden). Da UGM192 ein digitales 
Audiointerface ist, werden zur gleichen Zeit die Audiodaten aller Anwendungen immer mit der 
gleichen Samplerate verarbeitet. Nativ werden Sampleraten zwischen 44.1 und 192 kHz unterstützt. 

4.1 Latenz- und Puffereinstellungen 

Im Gegensatz zu Windows, werden unter OS X / macOS die Latenz-relevanten Einstellungen 
abhängig von der verwendeten Audioanwendung (z.B. DAW) verwaltet und normalerweise dort und 
nicht in unserem Control Panel eingestellt. Wenn Sie dazu mehr erfahren möchten, beachten Sie die 
Dokumentation Ihrer Audiosoftware. 
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5. Technische Daten 

- USB 3.1 Audiointerface mit USB-C Anschluss ("Typ C" nach "Typ C" Kabel mitgeliefert) 

- USB 2.0 kompatibel ("Typ A" nach "Typ C" Kabel mitgeliefert) 

- Stromversorgung über den USB Bus 

- separatere Stromanschluss für optionale mobile Stromversorgung (microUSB-Kabel wird 
benötigt, nicht im Lieferumfang enthalten) 

- professioneller Mikrofonvorverstärker: 
- symmetrischer 6.3mm Klinkenanschluss 
- 48V Phantomspeisung aktivierbar 
- -8.6dBu max. Eingangspegel 
- +10dB / +20dB Verstärkungsstufen 
- 2.2 kOhm Eingangsimpedanz 

- professioneller Hi-Z Instrumenteneingang: 
- umsymmetrischer 6.3mm Kllinkenanschluss 
- -8.4dBu max. Eingangspegel 
- 500 kOhm Eingangsimpedanz 

- 24-bit / 192kHz AD-Wandler: 
- 114dB Dynamkumfang A-gewichtet 
- THD+N -100dB (@ -1dBFS) 

- Line- und Kopfhörerausgang: 
- 6.3mm Stereo Klinkenanschluss 
- max. Ausgangspegel +6.4dBu (@ 0dBFS) 
- THD+N 0.0024% A-gewichtet (@ fs=48kHz)  
- 32~600 Ohm Impedanz 

- 24-bit / 192kHz DA-Wandler: 
- 114dB Dynamikumfang A-gewichtet 
- THD+N -100dB (@ 0dBFS) 

- unterstützt Windows 7 / 8 / 8.1 / 10 mit ASIO 2.0, MME, WDM und DirectSound 

- DirectWIRE-Unterstützung unter Windows mit virtuellen Audiokanälen für internes Loopback-
Recording 

- unterstützt OS X / macOS (10.9 und höher) über den native CoreAudio USB-Audiotreiber von 
Apple (keine Treiberinstallation notwendig) 

- 100% Class Compliant (keine Treiberinstallation bei vielen modernen Betriebssystemen 
notwendig, wie beispielsweise Linux mit ALSA oder bei iOS- und anderen mobile Geräten) 
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6. Allgemeine Hinweise 

Warenzeichen 

ESI und UGM192 sind Warenzeichen von ESI Audiotechnik GmbH. Windows ist ein eingetragenes 
Warenzeichen der Microsoft Corporation. Andere Produkt- und Markennamen sind Warenzeichen 
oder eingetragene Warenzeichen der jeweiligen Eigentümer. 

Kontakt 

Für technische Supportanfragen wenden Sie sich bitte an Ihren örtlichen Händler bzw. lokalen 
Vertrieb für ESI. Online finden Sie Support- und Kontaktinformation unter www.esi-audio.de. In 
Deutschland erreichen Sie den technischen Support auch telefonisch unter 07152 / 398880. 

Weitere Hinweise 

Alle Leistungsmerkmale, Spezifikationen und weitere Angaben können jederzeit ohne Ankündigung 
geändert. 

Teile dieses Handbuch können in Zukunft geändert werden. Bitte beachten Sie die Hinweise auf 
unserer Webseite www.esi-audio.de mit aktuellen Informationen. 


